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1 INTRODUCTION 1 

This document is the owner and user manual which describes the operation and administration of a copyrighted software program 2 

called the Family Legal Assistant (FLA) Database.  The program is available from the website at: 3 

http://sedm.org/ItemInfo/Programs/FLA/FLA.htm 4 

The purpose of the Family Legal Assistant (FLA) Database is to help : 5 

1. Automate and simplify the management of litigation in state and federal court. 6 

2. Track billable hours spent on each case or client. 7 

3. Track clients and cases. 8 

4. Monitor and manage progress of tasks that need to be done on each case. 9 

5. Limit access to client data to the specific attorney or person working on the case and anyone else he wants to separately 10 

authorize access to. 11 

6. Level the workloads across multiple attorneys within a law office. 12 

7. Track evidence, witnesses, and contacts. 13 

8. Serialize and track all documents pertaining to a case, their status, and their document numbers. 14 

9. Handle scheduling of events for each case. 15 

10. Automate mass marketing and mailings to all clients of appearing in the database. 16 

11. Standardize the folder labeling and organization for client records. 17 

 18 

The intended audience for the software includes the following: 19 

1. Sui juris litigants. 20 

2. Attorneys. 21 

3. Small law offices. 22 

4. Judges of common law courts. 23 

5. Those who are litigating their own divorce cases in state family courts. 24 

6. Those who are defending 25 

This software has been used to automate multiple small family law offices and was beta tested in these offices before being 26 

released.  It was developed with the input of family law attorneys, but is useful by all attorneys in small law offices. 27 

In the legal field, attorneys refer to this type of software as “Case Management Software”, and it can be so expensive that it is 28 

beyond the reach of sui juris or pro se litigants and smaller law offices.  Hence, we are offering it as a much less expensive 29 

alternative for those who cannot afford most other case management products. 30 

 31 

http://sedm.org/
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2 PROGRAM SETUP 1 

2.1 Minimum System Requirements 2 

The Family Legal Assistant (FLA) Database requires the following minimum resources to run properly: 3 

1. Any of the following operating systems: 4 

1.1. Windows 2000. 5 

1.2. Windows XP. 6 

1.3. Windows Vista. 7 

1.4. Windows 7. 8 

2. Any of the following versions of Microsoft Office installed: 9 

2.1. Microsoft Office 2000 Professional. 10 

2.2. Office XP Professional 2000. 11 

2.3. Microsoft Office 2003. 12 

2.4. Microsoft Office 2007. 13 

2.5. Microsoft Office 2010. 14 

2.6. Microsoft Office 2013 or later. 15 

2.7. Microsoft Office 365 or later 16 

3. 60 Mbytes disk space available. 17 

4. 128 Mbytes of RAM. 18 

5. At least one hard disk or partition OTHER than drive C:.  You cannot install the program on the C: drive. 19 

The program is NOT supported on either the Mac or on Microsoft Access 97.  If you have Microsoft Access 97 installed, then 20 

you will have to upgrade to Office 2000 as a minimum.  Sorry.  It’s just too much trouble to support and maintain multiple 21 

versions of the program.  For instance, we would need to have TWO or more computers to do the development, because Access 22 

97 and Access 2000 cannot reside on the same machine at the same time. 23 

2.2 Video Tutorial of installation process 24 

Our Support Page contains a video tutorial showing how to install the program.  You can find it at: 25 

SEDM Support Page, Section 11.1 

http://sedm.org/Support/Support.htm 

2.3 Getting help: Free installation 26 

If you have trouble setting up the program by following the procedure in this manual, you can as a last resort request a free 27 

installation of the program by us.  In order for us to complete the installation, you will need to follow the procedure below: 28 

1. Have your order number and original order confirmation email available, so we can confirm that you are an authorized 29 

user. 30 

2. Ensure that your computer is connected to the Internet. 31 

3. Install the following free software, so that we can use it to temporarily control your computer. 32 

TeamViewer 

https://www.teamviewer.com/en/ 

4. After you have located your order confirmation email and installed the Teamviewer software, submit a request to have us 33 

install the software via our Contact Us page.  Include your phone number, email address,name, the order number appearing 34 

in your order confirmation email, and a good time to contact you to initiate the installation: 35 

http://sedm.org/about/contact/ 36 

5. The installation takes usually only five minutes.  Sometimes we have to troubleshoot problems caused by viruses or older 37 

versions of the office suite.  If we have problems, the installation can take a half hour. 38 

2.4 Copying Standard Version files from the Zip file 39 

http://sedm.org/
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To install the program: 1 

1. You must have at least one hard disk or partition OTHER than drive C: to install the program on. For the purposes of this 2 

procedure, we assume that drive is drive D:.  If you disregard this requirement and copy the files to the D: drive, you will 3 

get the following error message that you will not be able to get rid of: 4 

 5 

2. Make a new directory on your computer in the following path and with the following name:  6 

D:\Database\FLA\ 7 

3. Download or copy the ZIP file to the directory you created above. 8 

4. Double click on the ZIP file to open it.  Your WINZIP of PKZIP program should start and open the ZIP archive.  If you have 9 

Windows XP, the ability to view ZIP files within the Windows Explorer is built in and you do not need a zip program to 10 

view or extract the data. 11 

5. From the ZIP viewer program or Windows Explorer (in Windows XP or later) select all files in the ZIP archive and extract 12 

them to the directory you created above. 13 

2.5 Making a Startup Icon to Run the Program 14 

You cannot run Family Legal Assistant (FLA) by simply clicking on the database file.  If you do, Microsoft access will give you 15 

all kinds of warning message, including the following: 16 

Figure 2-1:  Family Legal Assistant (FLA) Error if You Start the Program Without Using the Shortcut 17 

 18 

To prevent the error above, you will need a create Program Shortcut and start the program using the shortcut.  If you disregard 19 

the above warning and try to enter the program anyway without using the shortcut to start it up: 20 

1. Data import will not work. 21 

2. You will get frequent and unpredictable errors running the program. 22 

The Family Legal Assistant (FLA) Standard ZIP file has a sample/example shortcut file that you can click and drag onto your 23 

desktop and use as a starting point. 24 

http://sedm.org/
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In addition, you can find sample Family Legal Assistant (FLA) Shortcut Files at the following location on our website: 1 

SEDM Support Page, Section 11.2 

http://sedm.org/Support/Support.htm 

If the shortcut files you received with the program do not work, the ones on our Support Page above will probably do the trick. 2 

The following subsections will describe how to use the shortcut files both included with the program version you obtained and 3 

also from our website support page. 4 

2.5.1 Using the Shortcuts in the FLA Zip File 5 

The Family Legal Assistant (FLA) comes with three sample shortcuts inside the Zip distribution file you download as follows: 6 

Table 2-1:  Family Legal Assistant (FLA) Shortcut Files 7 

Shortcut File Name Version of Access You Have 

FLAShortcut2002 Access 2002 

FLAShortcut2003 Access 2003 

FLAShortcut2007 Access 2007 

FLAShortcut2010 Access 2010 

Which of the above three shortcut files you use will depend on the version of Microsoft Access you have.  Use the following 8 

procedure to determine which version you have and to copy the file to your desktop: 9 

1. Start up Microsoft Access by clicking Start->Programs. 10 

2. If access displays menus instead of a ribbon bar, you have Access 2000, 2002, or 2003.  Otherwise, you have Access 2007. 11 

3. If you have a menu bar, click “Help” in the menu and select “About”.  A dialog box will appear showing what version you 12 

have. 13 

4. Now that you know what version you have, select the appropriate shortcut file from above, and copy or drag the shortcut 14 

to your desktop. 15 

5. From now on, click on this shortcut to start the program file. 16 

2.5.2 Using the Shortcuts on the Support Page 17 

In addition to distributing sample shortcuts with the program, we  18 

2.5.3 Creating the Shortcut Manually 19 

To create a shortcut or icon that you can use to start up the program, follow the steps below.  These steps assume that you have 20 

both the “Fla2k.mdb” and “Secured.mdw” files copied to the “C:\Database\FLA\” directory: 21 

1. Open the Windows Explorer. 22 

2. Go to the directory where your Microsoft Access executable program is installed.  The name of the filename is 23 

“MSACCESS.EXE” and it is installed in the C:\Program Files\Microsoft Office\Office\” directory on most computers. 24 

3. Right-click on the “MSACCESS.EXE” program and select Create Shortcut.  A new file will be created in the Office 25 

program directory named “Shortcut to MSACCESS.EXE” 26 

4. Rename the “Shortcut to MSACCESS.EXE” file to “Family Legal Assistant (FLA)” 27 

5. Click on the new “Family Legal Assistant (FLA)” shortcut and then drag it either to your desktop or to your start bar at the 28 

bottom of your screen.  This will put a permanent shortcut on your Start Bar that you can click on at any time. 29 

6. Now right-click on the “Family Legal Assistant (FLA)” shortcut you just created on your Start Bar at the bottom of the 30 

screen and select “Properties”. 31 

Figure 2-2:  Family Legal Assistant (FLA) Icon properties dialog box 32 

http://sedm.org/
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 1 

7. Examine the “Target:” field in the “Family Legal Assistant (FLA) Properties” dialog box.  It should only contain the path to 2 

your Microsoft Access Executable at this time as follows: 3 

“C:\Program Files\Microsoft Office\Office\MSACCESS.EXE" 4 

8. Add to the end of the above line the following, assuming that your Family Legal Assistant (FLA) program is installed in the 5 

“C:\Database\FLA\” directory: 6 

D:\Database\FLA\fla2k.mdb /wrkgrp C:\Database\FLA\Secured.mdw /user liberty 7 

Therefore, the full command line would look like the following: 8 

D:\Database\FLA\fla2k.mdb /wrkgrp C:\Database\FLA\Secured.mdw /user liberty 9 

The purpose of the parameter “/wrkgrp C:\Database\FLA\Secured.mdw” is to tell MS Access what the workgroup security 10 

file is that you need to use.  Without starting up the database with this security file, then database security will malfunction 11 

and you will not be able to import old data from previous versions of the Family Legal Assistant (FLA) program.  The 12 

purpose of the “/user liberty” parameter is to login as the “decoder” user.  This is a predefined account allocated to all users 13 

who are using security in the database. 14 

http://sedm.org/
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WARNING:  If you put the Family Legal Assistant (FLA) in a directory other than that indicated above, and if the path to 

the directory has spaces in it, you will need to surround the pathname with quote marks.  For instance if the path is 

“C:\Documents and settings\User\Database\Fla2k.mdb” instead of “C:\Database\FLA\Fla2k.mdb” then the command line 

above would be: 

“C:\Program Files\Microsoft Office\Office\MSACCESS.EXE" “C:\Documents and settings\User\Database\Fla2k.mdb” /wrkgrp 

“D:\Documents and settings\User\Database\Secured.mdw” /user liberty 

If you don’t heed this warning, MS Access will give you TONS of errors when you try to start up the FLA from the icon. 

9. This will make the entire Target field to appear as below:: 1 

“C:\Program Files\Microsoft Office\Office\MSACCESS.EXE" D:\Database\FLA\Fla2k.mdb /wrkgrp 2 

D:\Database\FLA\Secured.mdw /user liberty 3 

Now you are ready to start the program quickly and easily. 4 

WARNING:  If you do not create a shortcut, then you will not be able to enter data on any of the forms, or import data from an 5 

older version of the program, or print properly.  This step is very important! 6 

If you would like further information about this section and a sample downloadable shortcut that you can reuse on your desktop, 7 

please visit the SEDM Support page below: 8 

Setting Up the Program Shortcut, Item #11.2 

http://sedm.org/Support/Support.htm 

2.6 Installing the Latest Office and Windows Updates 9 

Before attempting to run Family Legal Assistant (FLA) the first time, it is important to install all the latest Microsoft Office 10 

Updates and Service Packs off the web if you can.  If you don’t do this, Access has on occasion been known to crash and corrupt 11 

the database.  This step will prevent most installation errors we have seen before they happen.  To install free Office Updates off 12 

the web, follow the procedure below: 13 

1. Go to:  http://officeupdate.com 14 

2. Click on “Check for Updates” on the screen displayed. 15 

3. Look if there are any updates to install. 16 

4. If there are updates to install, then install them and reboot your computer. 17 

Similarly, it is also important to install all the latest free Windows updates on your system to prevent compatibility problems.  18 

Follow the procedure below to accomplish this: 19 

1. Open Internet Explorer. 20 

2. Select Tools->Windows Update 21 

3. Check for updates 22 

4. Install all updates and especially service packs. 23 

5. Reboot your computer for the changes to take effect. 24 

2.7 Set Microsoft Access Macro Security to Low to Disable “Sandbox mode” 25 

2.7.1 Access 2003 26 

If you are using version 2003 of Microsoft Access, then you will need to set the Macro Security level to “Low” as follows. 27 
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WARNING!:  If you do not follow the instructions below, then several features of the Family Legal Assistant (FLA) database 

will not work and the reports will contain the word “Error” and you may get the following error message when starting up 

Family Legal Assistant (FLA): 

Figure 2-3:  Error message if Microsoft Access 2003 Macro Security Level not set to "Low" 

 
 

1. Open Microsoft Access by clicking on its icon in the Start-> Programs menu.  Microsoft Access should start up. 1 

2. Select Tools->Macro->Security.  The following dialog box will appear. 2 

Figure 2-4:  Microsoft Access Macro Security Level Setting 3 

 4 

3. Click on the “Low” setting. 5 

4. Click the “OK” button. 6 

5. Close Microsoft Access by clicking on the “X” in the upper right corner or selecting File->Exit. 7 

2.7.2 Access 2007 8 

If you are using version 2007 or later of Microsoft Access, then you will need to set the Macro Security level to “Low” as follows. 9 
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WARNING!:  If you do not follow the instructions below, then several features of the Family Legal Assistant (FLA) database 

will not work and the reports will contain the word “Error” and you may get the following error message when starting up Family 

Legal Assistant (FLA): 

Figure 2-5:  Error message if Microsoft Access 2007 Macro Security Level not set to "Low" 

 

1. If you get the above warning, you can click on the Options Button and you will get the following: 

 

2. Click on “Enable this content” in the above dialog box and click “OK”. 

 

1. Open Microsoft Access by clicking on its icon in the Start-> Programs menu.  Microsoft Access should start up. 1 

3. Click the “Office Button”, which is the large circle in the upper left corner of the application   2 

4. A dialog box will open.  Click the “Access Options” button in the lower right corner. 3 

5. The following dialog box will appear. 4 

Figure 2-6:  Microsoft Access 2007 Macro Security Level Setting 5 
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 1 

6. Click on “Trust Center” on the left menu.  The following dialog box will appear: 2 
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 1 

7. Click on “Trust Center Settings” button on the right.  The following dialog box will appear: 2 
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 1 

8. Click on “Macro Settings” on the left.  The following dialog box will appear: 2 
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 1 

9. Click on “Enable all macros” on the right and then click “OK” in the lower right corner. 2 

10. Click the “OK” button. 3 

11. Exit the Microsoft Access application by clicking on the “X” in the upper right corner. 4 

2.8 Uninstalling Acrobat 7.0 and later Access Toolbars 5 

Adobe Acrobat 7.0 Standard and Professional and later by default will install a Microsoft Access PDF Maker menu item that 6 

interferes with the correct functioning of Family Legal Assistant (FLA).  If you are running Adobe Acrobat 7.0 Standard or 7 

Professional or later on the same computer as you will be running any version of Family Legal Assistant (FLA), you will therefore 8 

need to do the additional installation steps documented in this section. 9 

Symptoms of the compatibility problem:   10 

When you try to start Family Legal Assistant (FLA), you will get an error message saying that you don’t have exclusive database 11 

access.  You will have to hit “Esc” key several times to get past this error dialog box. 12 
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 1 

Resolution to the problem: 2 

1. Login to your computer as “Administrator” with full rights. 3 

2. Select “START->CONTROL PANEL -> ADD OR REMOVE PROGRAMS”. 4 

3. Select “Adobe Acrobat” in the program list. 5 

 6 

4. In the “Adobe Acrobat X.X” entry, click the “Change/Remove” button 7 

 8 

5. An Acrobat Setup Dialog box will appear.  Click “Next>” 9 

6. Click the “Modify” option and then click “Next>” 10 
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 1 

7. The Acrobat Setup Dialog below will appear: 2 

 3 

8. Locate the entry in the tree above entitled “Create Adobe PDF -> Acrobat PDFMaker -> Microsoft Access” and change it 4 

so that it displays an “X” and is de-installed. 5 
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 1 

9. Click “Next>” and complete the changes. 2 

10. Reboot your computer.  This completely removes the Adobe PDF Maker toolbars on Microsoft Access. 3 

2.9 Installing the Jet 4.0 Service Pack 4 

Starting with Microsoft Office Professional 2003, some versions of Microsoft Access will report the following error when you 5 

try to run the Family Legal Assistant (FLA): 6 

Figure 2-7:  Error Message for Access 2003 Running on Windows XP 7 

 8 

If you get the above error, please install the indicated Jet 4.0 Service Pack in order to get rid of the above message.  Below is the 9 

link to that service pack on the Microsoft website, which is for Windows XP only.  Other versions for other operating systems 10 

are also available: 11 
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http://www.microsoft.com/downloads/details.aspx?FamilyID=2deddec4-350e-4cd0-a12a-d7f70a153156&displaylang=en 1 

Below is a screenshot of the download screen for the above service pack to show you what it looks like. 2 

Figure 2-8:  Jet 4.0 Service Pack 8 download page 3 

 4 

2.10 Turning off the Access 2007 and later ribbon 5 

Access 2007 and later by default displays a ribbon at the top of every window.  You will NOT need this ribbon to use the Family 6 

Legal Assistant (FLA) program and you should turn it off, because it takes up valuable screen space.  Below is a picture of this 7 

ribbon: 8 

Figure 2-9:  Access 2007 and later Ribbon 9 

 10 

To turn off the Access 2007 and later ribbon, use the “Customize Quick Access Toolbar” option at the top of the screen and 11 

select “Minimize the Ribbon” as follows: 12 

Figure 2-10:  Access 2007 and later “Customize Quick Access Toolbar” 13 

http://sedm.org/
http://www.microsoft.com/downloads/details.aspx?FamilyID=2deddec4-350e-4cd0-a12a-d7f70a153156&displaylang=en


Chapter 3: Program Setup 2-16 

Family Legal Assistant, ver. 1.03 

Copyright  Sovereignty Education and Defense Ministry (SEDM)  http://sedm.org/ 

 1 

2.11 Logging Into the Database 2 

To log into the database, click on the program shortcut you created previously.  You will then be presented with a login screen: 3 

 4 

The default username and password is “liberty” and “liberty” respectively.  You can change this yourself after you login. 5 

2.12 Dealing with “references” errors during startup 6 

On some older versions of Microsoft Access, such as 2002, you may get the following error from the database during startup. 7 
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 1 

 2 

 3 

If you receive the above errors or any kind of error that indicates “broken reference”, then you will need to use our Contact Us 4 

page to have us fix the problem remotely.  Please ensure that you follow the procedures in section 2.3 earlier to both prepare 5 

your compute for remote support and contact us.  We are happy to help. 6 

2.13 Program Registration 7 

2.13.1 Background 8 

Family Legal Assistant (FLA) incorporates copy protection features that require the program to be registered once after initial 9 

installation on each unique computer you intend to run it on.  If you move the program to a different computer or a different disk 10 

on the same computer, you will need to re-register the program again. 11 

Program registration is done through the “Contact Us Page” in the menu on our site. 12 

http://sedm.org/about/contact/ 13 

 14 

WARNING:  All program functionality other than the Registration features will be completely disabled unless and until the 

program is registered with us on each system you will run it on.  An unregistered program will also display the following 

warning message when it starts up: 
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2.13.2 Registration Procedure 1 

Registration is very easy!  To register your program after initial installation on a new system, follow the procedure below: 2 

 3 

1. Start the Family Legal Assistant (FLA). 4 

2. Click on the “Register” button in the lower right corner.  The following screen will open. 5 

Figure 2-11:  Registration Screen 6 

 7 

3. Write down the “System ProfileCode” from the dialog above. 8 

4. Open your web browser and go to the following page: 9 

http://sedm.org 10 

5. Click on the “Contact Us” link in the AboutContact menu on the opening page at: 11 

6. Submit a request in the following format with all information listed included: 12 

Dear SEDM: 13 

Please promptly register my copy of the Family Legal Assistant (FLA) using the following 14 

information: 15 

My Name:  John Doe 16 

Order Number:  ORD2009061001 17 

http://sedm.org/
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SystemProfileCode:  2404415456 1 

Thanks, 2 

John Doe 3 

7. We will promptly (usually within 24 hours) email you back your registration information as follows: 4 

Dear John Doe, 5 

Thank you for obtaining our Family Legal Assistant (FLA) program.  Below is your 6 

registration information: 7 

Registered Owner:  John Doe 8 

RegCode:  1202207730 9 

The above RegCode will work on your computer as long as you own the computer.  You will 10 

need to re-register the program every time you try to run it on a different computer. 11 

WARNING:  If you move the program to a different computer after you register it and try to 12 

run it without re-registering it again, it won’t operate. 13 

Blessings, 14 

SEDM 15 

8. Start Family Legal Assistant (FLA) from the program shortcut you setup earlier on your desktop or Start Bar. 16 

9. Click on the “Register” button in the lower right corner of the opening screen of the program.  The following screen will 17 

display. 18 

Figure 2-12:  Registration Screen 19 

 20 

10. Enter the RegisteredOwner information from the registration email into the “RegisteredOwner” field of the form above. 21 

11. Enter the RegCode information from the registration email you received into the “RegCode” field of the form above. 22 

12. Click on the “Register” button of the Registration dialog box. 23 

13. If your registration is successful, you will see the following dialog box.  When you click on “OK” in the box 24 
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Figure 2-13: Registration Successful Confirmation Dialog Box 1 

 2 

13.1. The dialog will close and then 3 

13.2. The Registration form will close and then 4 

13.3. You will then be returned to the Family Legal Assistant (FLA) Main screen. 5 

13.4. The “Database Status” field on the Family Legal Assistant (FLA) Main Screen will change from “Locked” to 6 

“Operational”. 7 

 8 

14. If you made an error in entering the registration information, you will see the following error message. 9 

Figure 2-14: Registration Failure Dialog Box 10 

 11 
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2.14 Importing data from older versions of the program 1 

Starting with version 1.01 of the Family Legal Assistant (FLA), the capability is provided on the opening screen to import all 2 

data you entered from a previous version of the program.  This function is provided for use by those who make frequent use of 3 

the program but also like to update their program to the latest version frequently without having to reenter their data every time 4 

they upgrade the program.   5 

The import function is provided using the “Import Old Data” button on the opening screen.  After you push this button, a dialog 6 

box will appear as follows: 7 

Figure 2-15:  Import Data From Old Database dialog box 8 

 9 

In the “File name” field, fill in the path to the old MF Decoder program file and press the “Import” button.  Then you will see 10 

the following dialog box: 11 

Figure 2-16:  Import Option Selection dialog box 12 

 13 

This screen governs whether you want to delete the data currently in your MF Decoder database.  Select “Yes” or “No”.  Click 14 

“Cancel” to abort the import.  The MF Decoder then does the rest of the work for you.  15 

We emphasize that not all data is imported from your old database.  The table starting on the next page lists tables that are and 16 

are not imported:# 17 
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Table 2-2:  Data which the program imports from old versions 1 

# Table name Import? (Y/N) Applicable forms(s) Notes 

1 Acronyms N Acronyms This information is updated by us with each 

new version. 

2 Case managers Y Case managers  

3 Court cases Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.1 Court case charges Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.2 Court case checklists Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.3 Court case children Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.4 Court case documents Y  Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.5 Court case evidence Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.6 Court case journal Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.7 Court case property Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.8 Court case tasks Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.9 Court case trials Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.10 Court case visitations Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

3.11 Court case witnesses Y Court cases, Court cases (all), Clients-simple, Clients-

intermediate, Clients-all 

 

4 Courts Y Courts  

4.1 Court departments Y Courts  

4.2 Court clerks Y Courts  

4.3 Court judges Y Courts  

4.4 Court mediators Y Courts  

5 Database changes N Database changes  

6 Database transactions N Database transactions  

7 Firm information N Firm information  

8 Forms N Forms  

9 Glossary N Glossary  

10 Groups Y Groups  
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11 Group assignments Y Group assignments  

12 Group permissions Y Group permissions  

13 Internet yellow pages N Internet yellow pages  

14 Jurisdictions N Jurisdictions This information is updated by us with each 

new version. 

14.1 Jurisdiction authorities N Jurisdictions This information is updated by us with each 

new version. 

14.2 Jurisdiction courts N Jurisdictions This information is updated by us with each 

new version. 

14.3 Jurisdiction points of contact N Jurisdictions This information is updated by us with each 

new version. 

14.4 Jurisdiction reporters N Jurisdictions This information is updated by us with each 

new version. 

14.5 Jurisdiction tax notices N Jurisdictions This information is updated by us with each 

new version. 

15 Law information N Law information  

16 Lawyers Y Lawyers  

16.1 Lawyer fee schedule Y Lawyers  

17 Ministry resources N Ministry resources This information is updated by us with each 

new version. 

17.1 Ministry resource feedback N Ministry resources This information is updated by us with each 

new version. 

17.2 Ministry resource revision 

history 

N Ministry resources This information is updated by us with each 

new version. 

18 Personnel Y Personnel  

18.1 Personnel children Y Personnel  

19 Points of contact Y Points of contact  

19.1 Points of contact phone 

numbers 

Y Points of contact  

20 Quotations N Quotations This information is updated by us with each 

new version. 

21 Software releases N Software releases This information is updated by us with each 

new version. 

21.1 Software release changes N Software releases This information is updated by us with each 

new version. 

21.2 Software release users N Software releases This information is updated by us with each 

new version. 

22 User accounts Y User accounts  

 1 
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3 PROGRAM BASICS 1 

3.1 The Main User Screen 2 

The opening screen of the program provides a means to open any of the other screens in the program.  This form appears 3 

immediately after the user logs in.  The Caseload Summary screen also opens at the same time.   4 

This screen provides a switchboard used to open various screens within the program.  Simply click once on the form you want 5 

to open and click the “Select” button or alternatively double-click the screen  you want to open. 6 

Figure 3-1:  Opening screen 7 

 8 

The Object list contains two columns.  The left column, called the “Name” lists all of the screens in the database.  The right 9 

column lists what your permissions are within that screen.  There are four levels of permission, and higher numbered permission 10 

levels imply the permissions of all lower numbered levels.  The permission levels are: 11 

1. 0-Read:  Allows you to look existing records.  You cannot delete or change existing records or add new records. 12 
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2. 1-Add:  Allows you to add new records, view any record, but not change or delete existing records. 1 

3. 2-Modify:  Allows you to add new records, modify existing records, but not delete existing records. 2 

4. 3-Delete:  Allows you to modify or delete any existing records, or to add new records. 3 

To open up a form within the program, do one of the following to actions: 4 

1. Click once on the form name that you want in the Form List and then click the Select button. 5 

2. Double-click on the form name you want in the Form List. 6 

If you want to exit the program, then click on the Exit button. 7 

Below is a description of the various fields and buttons on the Main Screen: 8 

1. Current User:  The currently logged in User. 9 

2. DBMode:  Mode that database is in, which includes Advanced, Intermediate, or Simple.  This mode is set on a per user 10 

basis from within the Personnel or Personnel (all) screens. 11 

3. Category:  The category of work the user wishes to perform.  This includes: 12 

3.1. Administration 13 

3.2. Case management 14 

3.3. Database Administration 15 

3.4. Law and form information 16 

3.5. Research 17 

4. Object: The screen within the selected category.  To open a specific screen either click an item once and then push the 18 

“Select” button or simply double-click the item. 19 

5. Select button:  Opens the form selected in the Object listbox. 20 

6. Exit button:  Exits the FLA program. 21 

7. View POC:  View the Points of Contact Screen. 22 

8. Caseload Summary:  Opens the Caseload Summary form and populates it with all cases assigned to the currently logged in 23 

user. 24 

9. Program Registration Info:  Data about the current program registration. 25 

9.1. Registered To:  Current registered owner. 26 

9.2. Database Status:  Status of database.  Two options are possible 27 

9.2.1. Operational: Database is properly registered on the machine it is being run on and will be fully operational. 28 

9.2.2. Locked:  Database is not registered on the machine it is being run on and will be inoperative. 29 

3.2 Understanding the meaning of fields on forms 30 

Each form in the database includes a status bar in the lower left corner.  Whenever you move your cursor to a field , you can look 31 

in the lower left corner at the status bar for an explanation of what the field means.  Below is a screenshot from the “Firm 32 

Information” form that shows the cursor on the “FirmName” field and an arrow pointing the status bar explanation of that field: 33 

Figure 3-2:  Firm Information screen 34 
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 1 

3.3 Database modes (DBMode) 2 

The Database Mode determines what level of screens the user of the database sees when logged in.  The purpose of the setting is 3 

to simplify the display in the Object list on the Main Screen so that less advanced users are not confused by information they do 4 

not need to use or update.   5 

The mode that each user sees is determined by the settings for each user found in the Personnel screen.  Below is the section of 6 

that screen that sets the mode: 7 

Figure 3-3:  Personnel screen settings for DBMode parameter 8 

 9 

Here is a tabular summary of the effect of this setting: 10 

# Mode Screens that display in the object window 

1 Simple Clients-simple 

Court cases 

2 Intermediate Clients-intermediate 

Court cases 

3 Advanced Clients-adv 

Court cases-advanced 

 11 
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The Main screen displays which mode the logged in user is set for as follows: 1 

Figure 3-4:  Database Mode setting on Main Screen 2 

 3 

3.4 Security mode 4 

The Security Mode is displayed at the top of the following screens of FLA: 5 

1. Clients-simple 6 

2. Clients-simple (all) 7 

3. Clients-intermediate 8 

4. Clients-intermediate (all) 9 

5. Clients-adv 10 

6. Clients-adv (all) 11 

Security mode has two possible values: 12 

1. Manager. 13 

2. Non-manager. 14 

The Security Mode setting determines who the manager is for a specific client or court case record is on the Clients and Court 15 

Cases screens indicated above.  Those who are managers of a specific client or case record may view or change the record. The 16 

purpose of this feature is to protect the attorney-client privilege so that client information is not disclosed to or changed by other 17 

attorneys or paralegals who may also be sharing the database. 18 

Managers for specific cases are assigned from the Case Managers screen of FLA.   19 

Figure 3-5:  Case managers screen 20 
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 1 

Each case can have one or more Managers.  Those who are NOT managers assigned to a specific client or case may NOT view 2 

or change the corresponding record.   Cases are typically assigned by the practice owner of the law firm or by the Paralegal in 3 

charge of case leveling among attorneys. 4 

3.5 Printing reports 5 

Most forms include the ability to print what is on the screen that looks like this: 6 

However, only the following screens include a button in the upper right corner that allows you to print a preformatted and 7 

attractive and complete report: 8 

1. Personnel (all) 9 

2. POC mailing management 10 

3. Quotations 11 

4. Client mailing management (all) 12 

5. Clients-adv 13 
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6. Clients-adv (all) 1 

7. Clients-intermediate 2 

8. Clients-intermediate (all) 3 

9. Clients-simple 4 

10. Clients-simple (all) 5 

11. Court cases 6 

12. Court cases (all) 7 

13. Court cases-advanced 8 

14. Jurisdictions 9 

15. Ministry resources 10 

When you click the Print Report button, the following screen comes up: 11 

Figure 3-6:  Printing reports screen 12 

 13 

In all cases, whenever you try to print, the Default Printer will be the destination for your print job.  If you want to select a 14 

different printer, then you will need to: 15 

1. Select Start->Settings->Printers 16 

2. Right click on the printer you want to make the default printer. 17 

3. On the popup menu, select Set As Default Printer. 18 

Any one of the reports printed by the Family Legal Assistant (FLA), use the above screen.  You may find that there are occasions, 19 

where the report you wish to print contains places for information that you were not able to enter before the report printed.  In 20 

such as case, the Print Report Dialog above offers an option for printing the report as an “RTF File”.  This option allows you to 21 

save the report you are printing to an editable word processing file that you can open with Microsoft Word and further edit or 22 

embellish.  To save a report you are printing as an editable word processing file instead of printing it on the printer, follow the 23 

procedure below: 24 

1. In the “SELECT REPORT TYPE:” radio buttons, click on the “RTF File” option. 25 

2. In the “File name” field, enter the full path to the file and the full file name extension.  For instance, if you are saving a Case 26 

Status Report to the “Temp” directory on the “C:” drive and you are printing the report on January 1, 2007, the following 27 

syntax would be used in the “File name” field: 28 

C:\Temp\CaseStatus-20070101.rtf” 29 

“20070101” is a hierarchical date format representing January 1, 2007. 30 

3. Next, start up on your Microsoft Word program and open the RTF file you saved in the above directory.  Then you can 31 

directly edit the report before you print it.  Microsoft Word is the ONLY program that can directly edit RTF files produced 32 

by the Family Legal Assistant (FLA).  If you are using another word processing program, you will need to import and convert 33 
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the file before you can edit it.  Most word processing programs allow you to convert RTF files into their own proprietary 1 

format so you can edit or use them. 2 

The above procedure is also mentioned on our website in the Support Page under section 4.1, question #8. 3 

3.6 Deleting records 4 

In order to delete records, all you have to do is select the record by clicking on the record selector on the left side of the screen 5 

and then hit the “Delete” key.  For instance, if you want to delete an entire Client and all associated records and information on 6 

the “Clients-adv (all)” form, then click on the record selector pointed to in the picture below and push the “Delete” key: 7 

Figure 3-7:  Clients-Advanced Form, deleting records procedure 8 

 9 

3.7 Multiuser features 10 

The Family Legal Assistant (FLA) database is designed to be located on a share drive and simultaneously accessed by multiple 11 

users.  Record locking is implemented automatically by the database for those database records that are being updated or edited.  12 

Users wishing to see the record updates of others displayed on their screen must re-query the form they are viewing by pressing 13 

the F9 key. 14 

3.8 Navigating records 15 
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In order to be able to find the record that you want to update, you must be able to navigate database records.  Navigating records 1 

is done using either the keyboard or the Record Navigation Pane.  The Record Navigation panes are normally at the bottom of 2 

each database form.  Below is a sample Record Navigation Pane: 3 

Figure 3-8:  Navigation pane 4 

 5 

The Record Navigation Pane shown above describes two things: 1.  The left “1” indicates that record number 1 is displayed.  The 6 

right “1” shows how many total records are available for viewing.  You can enter a record number into the white box containing 7 

the left “1” (called the record number) and hit enter in order to take the database to the specific record number that you want to 8 

view.  The number you enter cannot be greater than the value in the numeric value to the right, because you can’t go beyond the 9 

end of the list.  There are also two buttons on the left of the record number and three buttons on the right of the record number.  10 

In the left group of two buttons, the left button takes you to the first record in the sequence while the right button takes you to 11 

the previous record.  In the three buttons to the right of the record number, the left button takes you to the previous record, the 12 

middle button takes you to the last record and the rightmost button blanks out the screen and puts the form into data entry mode 13 

so you can enter a new record. 14 

On the Clients-adv (all) screen, for instance, there are two levels of record navigation and each level has its own Record 15 

Navigation Pane.  These levels are as follows: 16 

1. Client records 17 

2. Subform records on each of the tabs under the Client displayed. 18 

Below is a screenshot of the Clients-adv (all) form showing the three Record Navigation Panes and what each is used for: 19 

Figure 3-9:  Navigating records on the Clients-adv (all) screen 20 
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 1 

 2 

Each form has two modes:  1.  Data Entry Mode; 2.  Read Only Mode.  The normal mode is Read Only mode.  You can put a 3 

record into Data Entry Mode by simply clicking on a field and attempting to edit it.  Then you will see the record selector on the 4 

left change and show a pencil icon, meaning that the form is in read only mode. 5 

The keyboard also allows for the same kind of record navigation as the Record Navigation Panes.  The thing you must remember 6 

is that you can’t use the keyboard to navigate within a form until you first put the cursor on a field that is part of the record that 7 

you want to navigate within.  For instance, on the Clients-adv (all) form, if you want to navigate the transaction records, then 8 

you must first click on a transaction record field and see the cursor blinking on that field.  Then you can use the following keys 9 

to navigate within transaction records.   10 

Table 3-1:  Record Navigation Keyboard Shortcuts 11 

Key Purpose Mode 

Ctrl-Home/Ctrl-End Move to first/last record within the form or subform that is 

selected 

Data Entry Mode 

Ctrl-PgUp or  

Ctrl-PgDown 

Move to previous/next record within the form or subform 

that is selected 

Data Entry Mode 
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Key Purpose Mode 

PgUp/PgDown Move to previous/next record within the form or subform 

that is selected 

Read Only Mode 

3.9 Function keys and Keyboard Shortcuts 1 

All forms in the database use the exactly the same functions keys.  Below is a list of the more common function keys: 2 

Table 3-2:  Keyboard Shortcuts 3 

Key Purpose 

Ctrl-F Put cursor on a field you want to search and use this function key to search the field for a value. 

Ctrl-F6 Toggle to a different open window 

Ctrl-F4 Close the currently active form or window 

Alt-F4 Exit the application 

Ctrl-Home/Ctrl-End Move to first/last record within the form or subform that is selected when in Data Entry Mode 

Ctrl-PgUp/Ctrl-

PgDown 

Move to previous/next record when in Data Entry Mode 

PgUp/PgDown Move to previous/next record when in Read Only (not Data Entry) Mode 

Shift-F2 Zoom in on a long or large text field and view the whole thing in a new window 

3.10 Data entry, generally 4 

Data for a new record is always entered in a blank form.  You will know the form is blank because the ID field will say 5 

“(AutoNumber)”. 6 

When you fill in a form full of information on the database, then you need to “commit” the data to the database, which means 7 

the contents of the record must be entered into the database.  If you never save the data you entered, then it will be lost when you 8 

either exit the form or the database.  This problem may also happen if you failed to complete all of the installation steps found in 9 

sections 2.2 through 2.7.2. 10 

Whenever you are entering data on a form, the form goes into “edit mode”.  You will know it is in edit mode because if the form 11 

has a record selector on the left side, the selector will change from a triangle to a little pencil.  The appearance of the pencil on 12 

the left indicates that you have new data on the form that needs to be saved in the database.  To save data in the database, do the 13 

following: 14 

1. Click your mouse cursor on any one of the fields in the record that you want to save. 15 

2. Do one of the following two things: 16 

2.1. Hit the “Next Record” button in the lower left corner for that record and then hit the “Previous Record” button to go 17 

back to the saved record. 18 

2.2. Hit the “Ctrl-PgDn” to move to the next record and then the “Ctrl-PgUp” button to move back to the original saved 19 

record. 20 

If you don’t follow the above steps to save each record that you entered, then you will lose your data.  Please don’t call us to 21 

complain about this oversight, because it’s operator error. 22 

If you would like an animated video demonstration of how to use the Family Legal Assistant (FLA), please visit the SEDM 23 

Support Page on our website below: 24 

Family Legal Assistant (FLA) Video Demonstration, Support Page, Section 11.3 

http://sedm.org/Support/Support.htm 

3.11 Adding new client records 25 

Attorneys and law offices typically handle multiple clients or multiple cases for each client.  The Clients screens of the Family 26 

Legal Assistant (FLA) database allow you to keep track of as many clients or cases as you like in as large a law office with as 27 
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many attorneys as you like, and it allows only the attorney working on a specific case to view information about that case in 1 

order to keep client information confidential.  As new clients or cases come in, they are typically entered on one of the multiple 2 

Clients screens provided: 3 

1. Clients-simple 4 

2. Clients-simple (all) 5 

3. Clients-intermediate 6 

4. Clients-intermediate (all) 7 

5. Clients-adv 8 

6. Clients-adv (all) 9 

The User displayed at the top of the Clients forms indicates which user you are working on at any given time, and you can use 10 

the record navigation pane at the bottom of the form or the search function (Ctrl-F) to find the user that you want to decode for.  11 

Note that you can both enter new users or update date for these users on any of the forms above.  To enter new users on in one 12 

of the above forms: 13 

1. By selecting the “Case Management” category on the opening screen. 14 

 15 
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2. In the “Object” list on the Opening Screen open one of the forms listed above by double clicking on it.  Below is what 1 

appears when you double click on “Clients-adv”.  It shows that it is ready to accept a new client record. 2 

 3 

3. The top area of the above form is for entering the basis client information.  Each version of the Client forms listed earlier 4 

contains a different subset or different organization for the client data but they may all be used for entry of new client records.  5 

We know the above form is waiting for a new client record because the “CaseID” field indicates “(New)”, meaning that it is in 6 

data entry mode. 7 

4. Enter the basic client information in the fields at the top of the form, such as lastname (“ClientLname”), firstname 8 

(“ClientFname”), etc.  9 

5. When you are finished entering all the information about the client on the form, you can save the content by doing one of 10 

the following: 11 

5.1 Navigating off the record using the Navigation Pane at the bottom of the form. 12 

5.2 Double-clicking on the Record Selector on the left side of the screen. 13 

After you have entered the user data, you can search for the user by searching a given field for a value.  For instance, click on 14 

the SSN field and then hit “Ctrl-F”.  This will bring up the search dialog box and you can type in the name, SSN, etc and search 15 

http://sedm.org/


Chapter 3: Program Basics 3-13 

Family Legal Assistant, ver. 1.03 

Copyright  Sovereignty Education and Defense Ministry (SEDM)  http://sedm.org/ 

for the user.  Alternatively, you can use the Navigation Pane at the bottom of the screen to sequence through the users until you 1 

find the one you want. 2 

At this point, you have entered your new user record and located him/her on the form, so you are now ready to begin updating 3 

client records for the user at any time as the case evolves. 4 

3.12 Technical Support 5 

You can post your technical support questions on our Family Legal Assistant (FLA) support forum at the following website.  6 

You must be a member of SEDM in order to use the forums at the address below: 7 

http://sedm.org/forums/ 8 

At the above address, see the section entitled “5.2  Family Legal Assistant (FLA) Help”.  Please be as specific as you can about 9 

reporting your bug.  For instance, please describe all of the following in your post on the above bulletin board or we will either 10 

delete your post or will demand more information: 11 

1. The version number of the Family Legal Assistant (FLA) program you are using. 12 

2. The operating system you are running, such as Windows 98, Windows 2000, Windows XP, Windows Vista, Windows 7, 13 

etc. 14 

3. The database form you were on when the error occurred (e.g. the “Clients-adv” form). 15 

4. The field within the database form that you were on when the error occurred. 16 

5. Exactly what you were doing on the form you identified when the problem occurred.  For instance, what key did you push 17 

or what did you click to make the problem happen? 18 

6. The steps we would have to take in order to consistently reproduce the problem so that we can fix it. 19 

7. Whether you paid for the program or STOLE it by illegally copying someone else’s copy in violation of the copyright. 20 

8. Your phone number so we can call you to ask questions about your problem. 21 

We provide all the instructions you need in this manual that comes with the database.  Since we are giving you the product at 22 

very low cost to begin with, please avoid asking for free tech support unless you actually paid for the program!  We will 23 

specifically ask you if you paid for the program before we will provide support. 24 

Please don’t call us on the phone to ask for technical support.  We won't return your phone calls for tech support and will rudely 25 

hang up if you call to ask questions.  We are only a staff of one with many other responsibilities, and we don't have time to help 26 

you or to spoon feed people who are too lazy to read either this manual or the online help system!  Please respect our privacy 27 

and our right to have a REAL LIFE by not calling for tech support.  The support forums should be more than adequate to meet 28 

your needs. 29 

Finally, if you see something about the program that is obviously flawed or incorrect, we definitely want to hear from you because 30 

we want to fix it ASAP. 31 

3.13 Online video tutorials 32 

Online video tutorials are available to help you with specific tasks while using the database.  You can view these tutorials for 33 

free at: 34 

SEDM Support Page, Section 11 

http://sedm.org/Support/Support.htm 

3.14 Feedback and volunteering to help us improve this program 35 

The Family Legal Assistant (FLA) program is a labor of love and a work in progress.  We do not claim that it is perfect and we 36 

know that there is much room for improvement.  As time permits, we intend to continually improve and enhance it, especially in 37 

the area of illegal technique detection and additional field decodes.  We solicit your feedback on how to improve it.  In particular, 38 

we solicit the following well-researched feedback from you on how to make it better: 39 
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1. Additional client information you need to keep track of. 1 

2. New reports that you need. 2 

3. Additional security features. 3 

4. Suggestions on how to improve this manual. 4 

You may post your suggestions for improving the program at: 5 

SEDM Forums, Forum #5.2: Family Legal Assistant (FLA) Software Support 

http://sedm.org/forums/index.php?showforum=75 

 6 

http://sedm.org/
http://sedm.org/forums/index.php?showforum=75


Chapter 4: Program Screens 4-1 

Family Legal Assistant, ver. 1.03 

Copyright  Sovereignty Education and Defense Ministry (SEDM)  http://sedm.org/ 

4 PROGRAM SCREENS 1 

The following subsections describe each major form or screen in the Family Legal Assistant (FLA) database.  The use of these 2 

screens is also explained in an online video included on the Family Legal Assistant (FLA) and listed on the opening page of the 3 

CD as “Family Legal Assistant (FLA) Video Tutorial”.  The file name is “FLA.wmv”.  This video is very helpful in giving you 4 

the basics of how to use the program. 5 

4.1 Login Screen 6 

To log into the database, click on the program shortcut you created previously.  You will then be presented with a login screen: 7 

 8 

The default username and password is “liberty” and “liberty” respectively.  You can change this yourself after you login. 9 

4.2 Opening screen 10 

The opening screen of the program provides a means to open any of the other screens in the program.  This form appears 11 

immediately after the user logs in.  The Caseload Summary screen also opens at the same time.   12 

This screen provides a switchboard used to open various screens within the program.  Simply click once on the form you want 13 

to open and click the “Select” button or alternatively double-click the screen  you want to open. 14 

Figure 4-1:  Opening screen 15 
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 1 

The Object list contains two columns.  The left column, called the “Name” lists all of the screens in the database.  The right 2 

column lists what your permissions are within that screen.  There are four levels of permission, and higher numbered permission 3 

levels imply the permissions of all lower numbered levels.  The permission levels are: 4 

1. 0-Read:  Allows you to look existing records.  You cannot delete or change existing records or add new records. 5 

2. 1-Add:  Allows you to add new records, view any record, but not change or delete existing records. 6 

3. 2-Modify:  Allows you to add new records, modify existing records, but not delete existing records. 7 

4. 3-Delete:  Allows you to modify or delete any existing records, or to add new records. 8 

To open up a form within the program, do one of the following to actions: 9 

1. Click once on the form name that you want in the Form List and then click the Select button. 10 

2. Double-click on the form name you want in the Form List. 11 

If you want to exit the program, then click on the Exit button. 12 

Below is a description of the various fields and buttons on the Main Screen: 13 
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1. Current User:  The currently logged in User. 1 

2. DBMode:  Mode that database is in, which includes Advanced, Intermediate, or Simple.  This mode is set on a per user 2 

basis from within the Personnel or Personnel (all) screens. 3 

3. Category:  The category of work the user wishes to perform.  This includes: 4 

3.1. Administration 5 

3.2. Case management 6 

3.3. Database Administration 7 

3.4. Law and form information 8 

3.5. Research 9 

4. Object: The screen within the selected category.  To open a specific screen either click an item once and then push the 10 

“Select” button or simply double-click the item. 11 

5. Select button:  Opens the form selected in the Object listbox. 12 

6. Exit button:  Exits the FLA program. 13 

7. View POC:  View the Points of Contact Screen. 14 

8. Caseload Summary:  Opens the Caseload Summary form and populates it with all cases assigned to the currently logged in 15 

user. 16 

9. Program Registration Info:  Data about the current program registration. 17 

9.1. Registered To:  Current registered owner. 18 

9.2. Database Status:  Status of database.  Two options are possible 19 

9.2.1. Operational: Database is properly registered on the machine it is being run on and will be fully operational. 20 

9.2.2. Locked:  Database is not registered on the machine it is being run on and will be inoperative. 21 

4.3 Administration 22 

The Administration Category on the opening screen is where law firm/office and firm personnel are managed by the database 23 

administrator.  It is also where mass mailings are produced to clients of the law firm or law firm/office. 24 
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 1 

4.3.1 Firm Information 2 

The Firm Information is the place where details about the law firm or law office may be entered into the database.  This 3 

information is used for automated form production, mailing label production, and other printed reports that need the firm 4 

information. 5 
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 1 

4.3.2 Personnel (all) 2 

The Personnel (all) form is where employees and attorneys of the law firm or law office that is using the database are entered 3 

and recorded.  This information is used to assign specific cases to specific attorneys and to limit access to client information to 4 

only the attorney assigned to the case. 5 

There are two versions of the Personnel form:   6 

1. The Personnel (all) form displays information about all personnel and is accessible only to the manager of the law firm. 7 

2. The Personnel form displays information about only the currently logged in user and is accessible to all users of the 8 

database. 9 
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 1 

4.3.3 Personnel (individual) 2 

The Personnel form is where employees and attorneys of the law firm or law office that is using the database are entered and 3 

recorded.  This information is used to assign specific cases to specific attorneys and to limit access to client information to only 4 

the attorney assigned to the case. 5 

There are two versions of the Personnel form:   6 

1. The Personnel (all) form displays information about all personnel and is accessible only to the manager of the law firm. 7 
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2. The Personnel form displays information about only the currently logged in user and is accessible to all users of the 1 

database. 2 

 3 

4.3.4 POC mailing management 4 

The POC Mailing Management screen is used to print mailing labels for all entities in the Points of Contact screen for the entire 5 

law firm who have the RecvMail field checked.  It is used to conduct targeted mailings to people in the Points of Contact table 6 

for marketing purposes. 7 
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 1 

4.3.5 Quotations 2 

The Quotations form is a place to record quotations you have come across that users think will be valuable in their writing or 3 

pleading preparation later. 4 
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 1 

4.4 Case Management 2 

The Case Management item of the Category box on the opening screen provides tools for: 3 

1. Creating or managing cases. 4 

2. Assigning case managers. 5 

3. Load leveling of cases across attorneys. 6 

4. Case status tracking. 7 

5. Checking conflicts of interest for new clients. 8 

6. Tracking courts and court contacts. 9 

7. Tracking Points of Contact. 10 
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 1 

4.4.1 Case managers 2 

The Case Managers screen is used to assign specific cases to specific attorneys or paralegals from the Personnel screen.  The top 3 

of the form lists the Client and Case Number and the bottom lists all the attorneys or paralegals from the Personnel screen who 4 

are assigned to work on the case and who have access to the files of the case. 5 

To add a new attorney or paralegal to work on a specific case, simply press the Question Mark on the subform in a blank record, 6 

select the attorney, and fill in the period of time during which that party will be working on the case and thereby have access to 7 

case and client data for that client. 8 
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 1 

4.4.2 Caseload summary 2 

The Caseload summary screen opens when the user first logs in.  The Caseload Summary screen is used by the currently logged 3 

in user to: 4 

1. Look at all Open clients and cases assigned to him at the present time.  The current user cannot look at cases assigned to 5 

other Personnel in the law firm or law office. 6 

2. Apportion his time among cases using the Timer and keep track of billable hours on each case.   7 

To track billable hours spent working on a specific case, the attorney simply selects the active case on the Cases tab and then 8 

clicks on the Start button to start the case timer.  When he is finished working on the case, he clicks the Stop button, which logs 9 

the total time spent and the total billable hours.  Billable hours are then added to the Trust Account tab for that particular client 10 

or case. 11 

The top of the form allows the user to filter the presentation to display cases only based on their CaseStatus, such as all Open 12 

cases, all Closed cases, or all cases in Collections. 13 

The bottom of the form contains a Client tab that allows the current user to select a specific client, and then track time spent 14 

working on that Client’s case.  Billing information will be automatically logged and the fee debited to the Client will also post 15 

to the Clients records within the database. 16 

The Cases tab tracks all cases assigned to the attorney by CaseNumber and CourtName instead of by Client. 17 
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The Tasks tab tracks all tasks that must be accomplished for all cases to which the attorney or user presently logged in is assigned. 1 

The Statistics tab tracks the breakdown of the different types of cases that the attorney is working on. 2 

There are two versions of the Caseload Summary screen:   3 

1. The Caseload Summary (all) screen displays information about all Clients and is accessible only to the manager of the law 4 

firm. 5 

2. The Caseload Summary screen displays only Clients assigned to the currently logged in user and is accessible to all users 6 

of the database. 7 

 8 

4.4.3 Caseload summary (all) 9 

The Caseload Summary (all) screen is used by the currently logged in user to: 10 

1. Look at all Open clients and cases being handed by the law firm at the present time.  The current user cannot look at cases 11 

assigned to other Personnel in the law firm or law office. 12 

2. Apportion the user’s time among cases using the Timer and keep track of billable hours on each case.   13 

To track billable hours spent working on a specific case, the attorney simply selects the active case on the Cases tab and then 14 

clicks on the Start button to start the case timer.  When he is finished working on the case, he clicks the Stop button, which logs 15 
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the total time spent and the total billable hours.  Billable hours are then added to the Trust Account tab for that particular client 1 

or case. 2 

The top of the form allows the user to filter the presentation to display cases only based on their CaseStatus, such as all Open 3 

cases, all Closed cases, or all cases in Collections. 4 

The bottom of the form contains a Client tab that allows the current user to select a specific client, and then track time spent 5 

working on that Client’s case.  Billing information will be automatically logged and the fee debited to the Client will also post 6 

to the Clients records within the database. 7 

The Cases tab tracks all cases assigned to the attorney by CaseNumber and CourtName instead of by Client. 8 

The Tasks tab tracks all tasks that must be accomplished for all cases to which the attorney or user presently logged in is assigned. 9 

The Statistics tab tracks the breakdown of the different types of cases that the attorney is working on. 10 

 11 

4.4.4 Casetype forms 12 

The Casetype Forms lists all forms associated with a specific type of case that have been cataloged on the Legal Forms and 13 

Templates screen.  Each type of case only uses a subset of all the forms available through the database. 14 
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To use this screen, search for the Case Type you want to see on the top of the screen, and then look at the forms that are available 1 

on the bottom. 2 

 3 

4.4.5 Client mailing management 4 

The Client Mailing Management screen is used to print mailing labels for all Clients of the law firm who have the RecvMail field 5 

checked.  It is used to conduct targeted mailings to people in the Clients table for marketing purposes. 6 

There are two versions of the Client Mailing Management screen:   7 

1. The Client Mailing Management (all) screen displays information about all Clients and is accessible only to the manager 8 

of the law firm. 9 

2. The Client Mailing Management screen displays only Clients assigned to the currently logged in user and is accessible to 10 

all users of the database. 11 
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  1 

4.4.6 Client mailing management (all) 2 
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The Client Mailing Management (all) screen is used to print mailing labels for all Clients of the law firm who have the RecvMail 1 

field checked.  It is used to conduct targeted mailings to people in the Clients table for marketing purposes.2 

 3 

4.4.7 Client summary 4 

The Client summary form displays all Clients assigned to only the currently logged in user of the database. 5 

The top of the form contains a filter that allows you to filter the form to display cases in the Open, Closed, or Collection states. 6 

There are two versions of the Client Summary screen:   7 

1. The Client Summary (all) screen displays information about all Clients and is accessible only to the manager of the law 8 

firm. 9 

2. The Client Summary screen displays only Clients assigned to the currently logged in user and is accessible to all users of 10 

the database. 11 
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4.4.8 Client summary (all) 2 

The Client summary (all) form displays all Clients within the database.  This form would typically only be used by the manager 3 

or database manager of the law form or law office on a need to know basis. 4 

The top of the form contains a filter that allows you to filter the form to display cases in the Open, Closed, or Collection states. 5 
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4.4.9 Clients-intermediate 2 

The Clients intermediate screen displays all details about Clients.  Main client information appears on the form and details are 3 

displayed on subform tabs at the bottom of the screen.  This screen displays only Clients accessible to and assigned to the 4 

currently logged in user. 5 

The “Security” field at the top displays whether you are the manager for the client record displayed.  If you are not, you may not 6 

edit or delete the information for that client. 7 

There are two versions of the Client Intermediate screen:   8 

1. The Clients Intermediate (all) screen displays information about all Clients and is accessible only to the manager of the 9 

law firm. 10 

2. The Client Intermediate screen displays only Clients assigned to the currently logged in user and is accessible to all users 11 

of the database. 12 
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 1 

4.4.10 Clients-intermediate (all) 2 

The Clients Intermediate (all) screen displays all details about Clients.  Main client information appears on the form and details 3 

are displayed on subform tabs at the bottom of the screen.  This screen displays all Clients served by the law firm or law office, 4 

and not just those for the currently logged in user.  Hence, access to this form should be limited only to management and database 5 

administrators. 6 

The “Security” field at the top displays whether you are the manager for the client record displayed.  If you are not, you may not 7 

edit or delete the information for that client. 8 
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 1 

4.4.11 Clients-simple 2 

The Clients simple screen displays all details about Clients.  Main client information appears on the form and details are displayed 3 

on subform tabs at the bottom of the screen.  This screen displays only Clients accessible to and assigned to the currently logged 4 

in user. 5 

There are two versions of the Client Simple form:   6 

1. The Clients Simple (all) form displays information about all Clients and is accessible only to the manager of the law firm. 7 

2. The Client Simple form displays only Clients assigned to the currently logged in user and is accessible to all users of the 8 

database. 9 
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 1 

4.4.12 Clients simple (all) 2 

The Clients Simple (all) screen displays all details about Clients.  Main client information appears on the form and details are 3 

displayed on subform tabs at the bottom of the screen.  This screen displays all Clients served by the law firm or law office, and 4 

not just those for the currently logged in user.  Hence, access to this form should be limited only to management and database 5 

administrators. 6 
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 1 

4.4.13 Conflict checker 2 

The Conflict Checker screen is used by attorneys who are considering accepting new clients.  It checks all the Client records at 3 

the firm and ensures that new clients you accept are not married to other existing clients.  This can be a serious conflict of interest. 4 
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4.4.14 Court cases 2 

The Court Cases screen lists court cases for the currently logged in user only.  It does not list court cases of other users or of the 3 

law firm in general. 4 

The “Security” field at the top displays whether you are the manager for the client record displayed.  If you are not, you may not 5 

edit or delete the information for that client. 6 

There are two versions of the Client Intermediate screen:   7 

1. The Court Cases (all) screen displays information about all Cases and is accessible only to the manager of the law firm. 8 

2. The Court Cases screen displays only Cases assigned to the currently logged in user and is accessible to all users of the 9 

database. 10 
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4.4.15 Court cases (all) 2 

The Court Cases (all) screen lists all court cases at the law firm for all users of the database, including those not assigned to the 3 

currently logged in user.  Because client information is sensitive and privileged, access to this form should be limited to practice 4 

owners and database administrators. 5 

The “Security” field at the top displays whether you are the manager for the client record displayed.  If you are not, you may not 6 

edit or delete the information for that client. 7 
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4.4.16 Court cases-advanced 2 

The Court Cases-Advanced screen is an expanded version of the Court Cases screen that provides additional tabs on the bottom 3 

half of the screen for recording information about complicated cases.  It lists court cases for the currently logged in user only.  It 4 

does not list court cases of other users or of the law firm in general. 5 

Unlike the Court Cases form, this form allows the user to filter cases based on their status, which includes:  Open, Closed, and 6 

Collections. 7 
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4.4.17 Courts 2 

The Courts screen tracks courts in which the law firm or law office has cases pending, at the municipal, state, or federal levels. 3 
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4.4.18 Form filler wizard 2 

The Form Filler Wizard is used to populate or merge forms from the Legal Forms and Templates screen with data from the 3 

Clients screen so as to produce forms useful during litigation. 4 

This functionality as of this writing is immature and not fully integrated with any of the forms on the Legal Forms and Templates 5 

screen. 6 
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4.4.19 Form filler wizard step editor 2 

The Form Filler Wizard Step Editor is used to create and edit steps used to create wizards.  A Wizard is a sequence of steps that 3 

fills in or print merges a legal form accessible from the Legal Forms and Templates screen. 4 
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4.4.20 Points of contact 2 

The Points of Contact screen tracks third party points of contact in your area or that are useful in your law practice.  These 3 

contacts would be OTHER than attorneys, or family law services and resources. 4 
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4.5 Database administration 2 

The Database Administration category on the Main Screen is where mainly Database Administrators and Practice Owners 3 

administer and manage the database.  Ordinary users do not and should not have access to this screen and may inadvertently and 4 

seriously damage data in the database if they do not know what they are doing. 5 
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4.5.1 Access log 2 

The Access Log screen tracks all historical logins and logouts of the database and the duration of the login.  This is useful in 3 

determining who is using FLA and when they are using it. 4 
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4.5.2 Database changes 2 

The Database Changes screen keeps track of all design changes to the Family Legal Assistant (FLA) by the creator, which  is 3 

SEDM, the version number of the database at the time of the change, and whether the help system and manual were updated to 4 

reflect the change. 5 
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4.5.3 Database maintenance 2 

The Database Maintenance screen is used by the system administrator to compact or repair the database.  Compacting the 3 

database reduces its size and speeds it up.  Repairing the database eliminates errors using Microsoft Access’ built in Jet engine. 4 
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4.5.4 Database transactions 2 

The Database Transactions screen provides a record of all changes to every form by every user of the database.  It tracks: 3 

1. The date and time of the change. 4 

2. The User who made the change. 5 

3. The form the change was entered from. 6 

4. The type of change. 7 

5. The field(s) that were affected by the change.  8 

http://sedm.org/


Chapter 4: Program Screens 4-35 

Family Legal Assistant, ver. 1.03 

Copyright  Sovereignty Education and Defense Ministry (SEDM)  http://sedm.org/ 

 1 

4.5.5 Group assignments 2 

The Group Assignments screen is used to assign specific database Users to one or more Groups listed in the Groups screen.  The 3 

users assigned must be entered in the Users screen first.  Additional information about the user is edited from the Personnel and 4 

Personnel (all) screens. 5 
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4.5.6 Group permissions 2 

The Group Permissions screen is used to specify the access level to data on various forms within the database to a very granular 3 

level.  The levels of access include the following: 4 

1. 1-Read 5 

2. 2-Add 6 

3. 3-Modify 7 

4. 4-Delete 8 

Each user is assigned to some combination of Groups on the Group Assignments Screen and each group has certain permissions 9 

on specific screens within the database.  The highest level of permission for all groups to which the user is assigned is what gets 10 

displayed on the Main Screen that opens when you login to the database.  Screens that are NOT listed under ANY of the groups 11 

to which the user is assigned do not appear in the Main Screen and may not even be displayed. 12 
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4.5.7 Groups 2 

The Groups screen provides a way to create and organize groups of various types of users of the database.  Each group can have 3 

its own list of users, its own list of forms that are presented on the Main Screen, and its own associated permissions on each 4 

screen.  This allows access to and changes to the data within the database to be precisely controlled so that data within the 5 

database does not become corrupted. 6 

Groups are created based on the specific roles that a database user may fill within the law firm or law office, such as: 7 

1. Attorneys. 8 

2. Court users. 9 

3. Database admins. 10 

4. Paralegals. 11 

5. Practice owners. 12 

6. Users. 13 

http://sedm.org/


Chapter 4: Program Screens 4-38 

Family Legal Assistant, ver. 1.03 

Copyright  Sovereignty Education and Defense Ministry (SEDM)  http://sedm.org/ 

 1 

4.5.8 Listbox options 2 

The Listbox Options screen controls which options are presented in various list boxes used throughout the Family Legal Assistant 3 

database.  The drop down listbox at the top of the screen provides a list of the various types of list boxes used throughout the 4 

database and the bottom of the screen lists all of the values made available within that type of listbox.  This allows the 5 

functionality of the database to be changed or enhanced without having administrative access to the design. 6 
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4.5.9 Replication management 2 

The Family Legal Assistant database can be used across multiple law offices and contains tools to allow the remote offices to 3 

synchronize their data with each other manually from the Replication Management form.  To synchronize with the database of a 4 

remote law office, the remote database must be made accessible from a share drive accessible from the computer that the database 5 

is being run from.  Then you use this screen to: 6 

1. Create new replicas for new satellite offices. 7 

2. Promote a specific replica to a design master. 8 

3. Synchronize with a remote replica. 9 
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4.5.10 Suggestions 2 

The Suggestions screen is used by any user to enter suggestions on how to improve the Family Legal Assistant and errors in the 3 

functionality that need to be fixed.  There is a check box for our use that allows the developer, SEDM, to record whether the 4 

change was implemented. 5 
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4.5.11 User accounts 2 

The User Accounts screen is where database accounts are created and maintained, and the time interval when they are active may 3 

be established.  It works in tandem with the Personnel screen.  The Personnel screen lists all personnel at the law office, while 4 

the User Accounts screen controls the subset of Personnel who have accounts within the database.  Not everyone at a law firm 5 

needs access to the database. 6 
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Notes on this form: 2 

1. You must enter a DateStart prior to the current date in order for the account to be active.  Inactive accounts cannot login to 3 

the database. 4 

2. Every record must have a Personal Identifier, which is a unique integer value.  The field cannot be left blank. 5 

4.6 Law and form information 6 

The Law and Form Category of the Main Screen is used to locate information about jurisdictions, laws, statutes, terms, acronyms, 7 

and generally to research legal subjects. 8 
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4.6.1 Acronyms 2 

The Acronyms screen lists various technical, legal, and government acronyms useful in the telecommunications, government, 3 

and legal fields. 4 
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4.6.2 Glossary 2 

The Glossary screen provides definitions for hundreds of different technical and legal terms.  The WebAddr field is used to 3 

record the place on the World Wide Web where the definition was extracted. 4 
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4.6.3 Internet yellow pages 2 

The Internet Yellow Pages screen tracks internet sites.  It categorizes the various sites, provides the domain name and the IP 3 

address.  It also allows you to click on the site by clicking on the hostname. 4 
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4.6.4 Jurisdictions 2 

The Jurisdictions screen tracks critical details about all state and federal jurisdictions throughout the USA.  It tracks franchise 3 

statutes, whether each jurisdiction has income taxes, the date they jurisdiction joined the Union, its abbreviation, the type of 4 

jurisdiction, and many weblinks to various information sources about the jurisdiction such as courts, Points of Contact, 5 

Authorities, etc. 6 

This particular screen also prints out an attractive report that is very useful as a reference tool.  The reports that it prints out is 7 

found on our website: 8 

SEDM Jurisdictions Database, Litigation Tool #10.010 

LITIGATION TOOLS PAGE: http://sedm.org/Litigation/LitIndex.htm 

DIRECT LINK: http://sedm.org/Litigation/PracticeGuides/SEDMJurisdictionsDatabase.pdf 
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4.6.5 Legal forms and templates 2 

The Legal Forms and Templates screen contains a database of many different types of forms used in law practice.  Many are in 3 

editable Microsoft Word format and are embedded directly in inside the database. 4 
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4.6.6 Ministry Resources 2 

The Ministry Resources screen displays all resources available through the Sovereignty Education and Defense Ministry (SEDM) 3 

website, including all forms, publications, litigation tools, response letters, user manuals, pleadings, videos, etc.  The form is read 4 

only and may not be changed by the user. 5 

The content of this form is populated by the ministry and is used to produce the following forms on the SEDM website: 6 

1. SEDM Resource Index, Form #01.008 7 

http://sedm.org/Forms/FormIndex.htm 8 

2. SEDM Resource Revision History, Form #01.009 9 

http://sedm.org/Forms/FormIndex.htm 10 
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4.6.7 Points of contact 2 

The Points of Contact screen tracks third party points of contact in your area or that are useful in your law practice.  These 3 

contacts would be OTHER than attorneys, or family law services and resources. 4 
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4.7 Research 2 

The Research Category of the Main Screen provides  3 
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4.7.1 Acronyms 2 

The Acronyms screen lists various technical, legal, and government acronyms useful in the telecommunications, government, 3 

and legal fields. 4 
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4.7.2 Law information 2 

The Law Information screen provides a database of legal research sources, such as web sites, books, and subscription services. 3 
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4.7.3 Legal services and resources 2 

The Legal Services and Resources screen provides a place to track organizations and individuals providing legal services in your 3 

area.  This screen presents a subset of the information found on the Points of Contact screen and Points of Contact table. 4 
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4.7.4 File cabinet 2 

The File Cabinet screen is used store and organize documents.  The entire document can be embedded within the Document 3 

field.  You can use the search or the filter functions to locate documents on a specific subject. 4 
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4.7.5 Glossary 2 

The Glossary screen provides definitions for hundreds of different technical and legal terms.  The WebAddr field is used to 3 

record the place on the World Wide Web where the definition was extracted. 4 
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4.7.6 Lawyers 2 

The Lawyers screen provides a place to record information about Lawyers practicing in various areas of specialty in your area.  3 

It can also be used to shop for a lawyer. 4 
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4.7.7 MSA clauses 2 

The MSA Clauses form is a database of clauses used in the preparation of Marital Settlement Agreements in divorce cases.  The 3 

list of clauses was prepared by a family law attorney originally for use in California. 4 
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4.7.8 Points and authorities 2 

The Points and Authorities screen is used to keep track of points and authorities on various subjects.  You can use the search 3 

function or the filter function to locate points and authorities on a specific subject.  Points and authorities are typically used in 4 

the preparation of memorandums of law filed in association with a court pleading. 5 
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5 DATABASE ADMINISTRATION 1 

Within your law firm, law office, or home computer, someone will need to be tasked with administering the database.  2 

Administrative functions are necessary to: 3 

1. Ensure optimal operation of the database. 4 

2. Recover from errors. 5 

3. Backup to the database to protect all the work that is put into updating it. 6 

The following subsections describe the more common administrative tasks performed by the database administrator. 7 

5.1 Database specifications 8 

The following limits apply to the operation of the Family Legal Assistant: 9 

1. Maximum database size:  2GB. 10 

2. Maximum number of concurrent users:  255. 11 

3. Versions of Microsoft Access supported:  2000, 2002-2003, 2007, and 2010. 12 

4. Number of unique database screens:  48. 13 

5. Maximum size of a memo field:  65,535 bytes. 14 

6. Format:  Microsoft Access 2000 MDB format. 15 

7. Security implementation: 16 

7.1. User level security. 17 

7.2. Group level security. 18 

7.3. Database transaction logging of all transactions. 19 

7.4. Logging of all logins and logouts. 20 

5.2 About Database Permission Levels 21 

The Family Legal Assistant (FLA) implements five levels of database security access for each of the screens in the database.  22 

These access levels are assigned from the Group Permissions screen.  The levels are: 23 

Table 5-1:  Database Permission Levels 24 

Permission  

level 

Description 

1-Read Allows the user to only read the records displayed.  User cannot add new records, modify or delete 

existing records,  or enter design mode on the screen. 

2-Add Allows the user to both read existing records and add new records on the screen.  User cannot modify or 

delete existing records or enter design mode on the screen. 

3-Modify Allows the user to read or modify existing records, or to add new records  on the screen.  User cannot 

delete existing records or enter design mode on the screen. 

4-Delete Allows the user to read or modify or delete existing records, or to add new records  on the screen.  User 

cannot enter design mode on the screen. 

5-Design User can enter design mode for the screen, and also read existing records, add or modify or delete existing 

records. 

5.3 Creating User Accounts and Personnel 25 

There are three screens within FLA that pertain to Users: 26 

1. User Accounts. 27 

2. Personnel. 28 

3. Personnel (all). 29 
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The Personnel and Personnel (all) screens are where all personnel within the law firm or law office are created and entered.  A 1 

subset of those personnel will be Users of the FLA database.   2 

In order to create a User account, you must: 3 

1. Open the Personnel or Personnel (all) screen. 4 

2. Create a new record in the Personnel or Personnel (all) screen. 5 

3. Close the Personnel or Personnel (all) screen. 6 

4. Open the User Accounts screen. 7 

5. Initialize the person entered in step 1 from the User Accounts screen: 8 

5.1. Enter the DateStart field.  This value must be either today or some date in the past in order to grant the new user an 9 

operative account.  Entering a DateStart value after today or some time in the future will not produce a functional 10 

account. 11 

5.2. Enter a UserName for the FLA user. 12 

5.3. Enter a Password for the FLA user. 13 

6. Resynchronize database security by: 14 

6.1. Selecting Actions->Resynchronize Database Security from the menus in MS Access 2000 through 2003. 15 

6.2. Selecting Add-Ins->Actions->Resynchronize Database Security from the menus in MS Access 2007 or 2010. 16 

If you omit the last step, step #6 above, the user account will not be full initialized and the user will not be able to login to the 17 

database. 18 

Any of the following situations will cause the user account to not be created when the database security is resynchronized: 19 

1. The DateStart is after today or some date in the future. 20 

2. The DateExpire is either today or some time in the past. 21 

3. There is no UserName entered. 22 

4. There is no Password entered.  All accounts must have a user password. 23 

If any of the above problems occur on this screen, all User accounts with this problem will not function until the problem is fixed 24 

and the database security is resynchronized. 25 

5.4 Managing Groups and Group Permissions 26 

Database security allows for the creation and maintenance of Groups.  A Group is a collection of users who share common 27 

permissions and security settings.  We recommend creating groups that correspond to roles within your law firm or law office.  28 

Below are the default Groups defined within FLA, and each is organized by role: 29 

Table 5-2: Pre-defined FLA Groups 30 

Group Name Description 

Attorneys Attorneys who need access to clients they are working for. 

Court users Those administering the courts or common law courts. 

Database admin The local database administrator, who is usually an Information Technology (IT) professional. 

Paralegals Paralegals who work for the Attorney users and who prepare briefs and pleadings for the attorneys.  

These users, like the Attorney users, must have access to client files for all clients who are assigned to 

the attorney they work for. 

Practice owners The owner of the law firm or law office, who has global access to all user, case, and client 

information.  He supervises all the attorneys and paralegals. 

Users Ordinary users who are not assigned to any specific clients. 

After a User account is created in section 5.3 earlier, the user must then be assigned to one or more specific database Groups.  If 31 

they are not assigned to ANY group, then they will not see most of the screens available in the database from the Main Screen 32 

and will be able to do very little.  Assignment of users to specific groups is covered in the next section. 33 

Groups are created and changes from the Groups form: 34 

http://sedm.org/
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Group Permissions are set from the Group Permissions form: 2 

http://sedm.org/
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The Group Permissions form contains a list of all screens that can be opened by users who are assigned to the group.  The screens 2 

that can be opened are listed in the ObjName column.  After an object or screen is added to a group, the permissions on that 3 

screen must then be set using the drop-down list in the Permissions column. 4 

5.5 Assigning Users to Groups 5 

Once the groups are defined and the screens are associated with the groups, the last step is to assign existing Users to each group 6 

using the Group Assignments screen: 7 

http://sedm.org/
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The top of the Group Assignments screen lists the user whose assignment is being set, and the bottom of the screen lists all the 2 

groups that the selected user is a member of. 3 

To add a group to a specific user, click on the down arrow in the Group column within a blank record, and select the group you 4 

want to add.  Then save the record. 5 

5.6 Tracking down malicious users of the database 6 

Users of FLA sometimes turn malicious and try to delete or corrupt valuable data within the database.  This might happen when, 7 

for instance, personnel are terminated and they want to do damage to the system on their way out.  Family Legal Assistant (FLA) 8 

provides a way to track down such malicious changes to the database.  The Database Transactions screen provides a read only 9 

view of all changes that have been made to any screen in the database, the time they were made, and the fields that were changed.  10 

The database manages this screen and users may not change the content. 11 

http://sedm.org/
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5.7 Setting Up and Managing Database Replication Across Multiple Law Offices 2 

Family Legal Assistant (FLA) permits multiple law offices to use the same database file over a shared network.   3 

5.8 Compacting and Repairing the Database 4 

Over time, the size of the FLA database can grow exponentially.  The database grows when records are changed or deleted.  On  5 

a periodic basis of at least weekly, it is a good idea for the database administrator to compact the FLA database in order to recover 6 

unused and excess space in order that the size of the data file will remain as small as possible and so that the database performance 7 

will be optimal.   8 

In addition, the database may become corrupted by the computer shutting down in the middle of completing a database update.  9 

When this happens or if the database experiences an error during login, the database administrator should consider compacting 10 

the database file.   11 

Both compacting the database to reduce its size and repairing the database are done from the Database Maintenance screen: 12 

http://sedm.org/
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 2 

The Database Maintenance screen has buttons for both compacting and repairing the database.  It also includes a “Target path:” 3 

field which is used during the repair, in order to specify the filename of the new database file that is produced during the repair 4 

process.  You do not need to fill in the “Target path:” field if you are only compacting the database. 5 

5.9 Enhancements to the FLA database 6 

The Family Legal Assistant (FLA) database is offered as a cost-effective, shrink-wrap, turn-key solution to managing cases as a 7 

sui juris litigant, and in small and medium law offices and law firms.  The built-in security system prevents even the database 8 

administrator from viewing or modifying the design of the forms, queries, tables, and macros within the database.   9 

It may be that after using the database within your law practice, you may decide you would like to either customize it or suggest 10 

improvements to its functionality.  If you would like to make suggestions, we encourage you to go to our Member Forums and 11 

post your suggestions at: 12 

SEDM Member Forums, Forum 5.4:  Family Legal Assistant Support 

http://sedm.org/forums/ 

You may also wish to make custom changes to the database to accommodate the unique needs of your law office or law practice.  13 

We would love to work with you in enhancing the database for hire.  We have experienced database programmers with over 17 14 

years of experience working with Microsoft Access starting with the very first version of Microsoft Access, version 1.0 in 1993. 15 

If you would like to hire us to implement a customized or enhanced version of FLA or for any other type of Microsoft Access 16 

database programming, please submit a request to: 17 

SEDM Contact Us Page 

http://sedm.org/storepublic/index.php?app=ccp0&ns=contact 

 18 
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6 RESOURCES FOR FURTHER STUDY 1 

6.1 Technical Support Resources 2 

The SEDM Website Support Page provides answers to the most frequently asked questions about the Family Legal Assistant 3 

(FLA), as well as video tutorials on the basics of the program at the address below: 4 

SEDM Website Support Page 

http://sedm.org/Support/Support.htm 

6.2 Website Resources 5 

The following websites are arranged by subject to make it easier to find the information you need relating to legal research and 6 

use of the Family Legal Assistant (FLA) database.  The documents are listed in decreasing order of value, where the lowest 7 

number is the highest value to the subject of legal research and the FLA: 8 

Table 6-1:  Web Resources Relating to Law, Litigation, and Legal Research 9 

# Subject Source Comments 

1. SEDM Website 

1 SEDM Website http://sedm.org Main SEDM website 

2 Litigation Tools Page http://sedm.org/Litigation/LitIndex.htm Litigation Tools Page 

3 SEDM Subject Index http://sedm.org/Search/SubjectIndex.htm Index of all site content, organized by 

subject 

2. Family Guardian Website 

2.1 Legal Research Sources http://famguardian.org/TaxFreedom/ 

LegalRef/LegalResrchSrc.htm 

Legal research sources on every subject 

2.2 State Legal Resources http://famguardian.org/TaxFreedom/LegalRef/ 

StateLegalResources.htm 

Legal reference for all 50 states 

2.3 Family Law, Dating, Marriage, and Divorce http://famguardian.org/Subjects/FamilyLaw/ 

FamilyLaw.htm 

Family law resources for freedom fighters 

2.4 Family Issues http://famguardian.org/Subjects/FamilyIssues/ 

familyissues.htm 

Political issues affecting families. 

 10 
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